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Legal Notices
Copyright © 2004 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, stored on a retrieval system, or 
transmitted without the express written consent of the publisher. This manual, and any portion thereof, may not be copied without the express written 
permission of Novell, Inc.

Novell, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and specifically disclaims any express 
or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication and to 
make changes to its content, at any time, without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and specifically disclaims any express or implied warranties 
of merchantability or fitness for any particular purpose. Further, Novell, Inc. reserves the right to makes changes to any and all parts of Novell 
software, at any time, without any obligation to notify any person or entity of such changes.

This product may require export authorization from the U.S. Department of Commerce prior to exporting from the U.S. or Canada.

Copyright ©1997, 1998, 1999, 2000, 2001, 2002, 2003 SilverStream Software, LLC. All rights reserved. 

SilverStream software products are copyrighted and all rights are reserved by SilverStream Software, LLC 

Title to the Software and its documentation, and patents, copyrights and all other property rights applicable thereto, shall at all times remain solely and 
exclusively with SilverStream and its licensors, and you shall not take any action inconsistent with such title. The Software is protected by copyright 
laws and international treaty provisions. You shall not remove any copyright notices or other proprietary notices from the Software or its 
documentation, and you must reproduce such notices on all copies or extracts of the Software or its documentation. You do not acquire any rights of 
ownership in the Software.

Patent pending.
Novell, Inc.
404 Wyman Street, Suite 500
Waltham, MA  02451
U.S.A.

www.novell.com 
Installing Novell exteNd

June 2004
Online Documentation:  To access the online documemntation for this and other Novell products, and to get updates, see 
www.novell.com/documentation.

New http://www.novell.com/documentation/
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Novell Trademarks
ConsoleOne is a registered trademark of Novell, Inc.

eDirectory is a trademark of Novell, Inc.

GroupWise is a registered trademark of Novell, Inc.

exteNd is a trademark of Novell, Inc.

exteNd Composer is a trademark of Novell, Inc.

exteNd Director is a trademark of Novell, Inc.

iChain is a registered trademark of Novell, Inc.

jBroker is a trademark of Novell, Inc.

NetWare is a registered trademark of Novell, Inc.

Novell is a registered trademark of Novell, Inc.

Novell eGuide is a trademark of Novell, Inc.

SilverStream Trademarks
SilverStream is a registered trademark of SilverStream Software, LLC. 

Third-Party Trademarks
All third-party trademarks are the property of their respective owners.

Third-Party Software Legal Notices

The Apache Software License, Version 1.1
Copyright (c) 2000 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided  that the following conditions are met: 1. 
Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary 
form must reproduce the above copyright  notice, this list of conditions and  the following disclaimer in the documentation and/or other materials 
provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: 
"This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may 
appear in the software itself, if and wherever such third-party  acknowledgments normally appear. 4. The names "Apache" and "Apache Software 
Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written  permission, 
please contact  apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their  name, 
without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES,  INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY  AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO 
EVENT SHALL  THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY  DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES  (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF  USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR  TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT  OF THE USE  OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

JDOM.JAR
Copyright (C) 2000-2002 Brett McLaughlin & Jason Hunter. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. 
Redistributions of source code must retain the above copyright notice, this list of conditions, and the  following disclaimer. 2. Redistributions in 
binary form must reproduce the above copyright notice, this list of conditions, and  the disclaimer that follows these conditions in the documentation 
and/or other materials provided with the  distribution. 3. The name "JDOM" must not be used to endorse or promote products derived from this 
software without prior written permission. For written permission, please contact license@jdom.org. 4. Products derived from this software may not 
be called "JDOM", nor may "JDOM" appear in their  name, without prior written permission from the JDOM Project Management (pm@jdom.org).

In addition, we request (but do not require) that you include in the end-user documentation provided with  the redistribution and/or in the software 
itself an acknowledgement equivalent to the following: "This product includes software developed by the JDOM Project (http://www.jdom.org/)." 
Alternatively, the acknowledgment may be graphical using the logos available at  http://www.jdom.org/images/logos.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES,  INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO 
EVENT SHALL  THE JDOM AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF  USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT  (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS  SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Sun
Sun Microsystems, Inc. Sun, Sun Microsystems, the Sun Logo Sun, the Sun logo, Sun Microsystems,  JavaBeans, Enterprise JavaBeans, JavaServer 
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Pages, Java Naming and Directory Interface, JDK, JDBC, Java, HotJava, HotJava Views, Visual Java, Solaris, NEO, Joe, Netra, NFS, ONC, ONC+, 
OpenWindows, PC-NFS, SNM, SunNet Manager, Solaris sunburst design, Solstice, SunCore, SolarNet, SunWeb, Sun Workstation, The Network Is 
The Computer, ToolTalk, Ultra, Ultracomputing, Ultraserver, Where The Network Is Going, SunWorkShop, XView, Java WorkShop, the Java 
Coffee Cup logo, Visual Java, and NetBeans are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other 
countries.

Indiana University Extreme! Lab Software License
Version 1.1.1

Copyright (c) 2002 Extreme! Lab, Indiana University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided  that the following conditions are met: 1. 
Redistributions of source code must retain the above copyright notice, this list of conditions and the  following disclaimer. 2. Redistributions in binary 
form must reproduce the above copyright notice, this list of conditions and  the following disclaimer in the documentation and/or other materials 
provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: 
"This product includes software developed by the Indiana University Extreme! Lab (http://www.extreme.indiana.edu/)." Alternately, this 
acknowledgment may appear in the software itself, if and wherever such third-party  acknowledgments normally appear. 4. The names "Indiana 
University" and "Indiana University Extreme! Lab" must not be used to endorse  or promote products derived from this software without prior written 
permission. For written permission,  please contact http://www.extreme.indiana.edu/. 5. Products derived from this software may not use "Indiana 
University" name nor may "Indiana  University" appear in their name, without prior written permission of the Indiana University.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE AUTHORS, COPYRIGHT HOLDERS OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF  ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

Phaos
This Software is derived in part from the SSLavaTM Toolkit, which is Copyright ©1996-1998 by Phaos Technology Corporation. All Rights 
Reserved. Customer is prohibited from accessing the functionality of  the Phaos software.

W3C
W3C® SOFTWARE NOTICE AND LICENSE

This work (and included software, documentation such as READMEs, or other related items) is being  provided by the copyright holders under the 
following license. By obtaining, using and/or copying this work, you (the licensee) agree that you have read, understood, and will comply with the 
following terms and conditions.

Permission to copy, modify, and distribute this software and its documentation, with or without  modification, for any purpose and without fee or 
royalty is hereby granted, provided that you include the following  on ALL copies of the software and documentation or portions thereof, including 
modifications: 1.The full text of this NOTICE in a location viewable to users of the redistributed or derivative work. 2.Any pre-existing intellectual 
property disclaimers, notices, or terms and conditions. If none exist,  the W3C Software Short Notice should be included (hypertext is preferred, text 
is permitted) within the body of any redistributed or derivative code. 3. Notice of any changes or modifications to the files, including the date changes 
were made. (We  recommend you provide URIs to the location from which the code is derived.) 

THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS," AND COPYRIGHT  HOLDERS MAKE NO REPRESENTATIONS OR 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING  BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR ANY  PARTICULAR PURPOSE OR THAT THE USE OF THE SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE ANY 
THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER  RIGHTS.

COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL OR  CONSEQUENTIAL DAMAGES ARISING 
OUT OF ANY USE OF THE SOFTWARE OR DOCUMENTATION.

The name and trademarks of copyright holders may NOT be used in advertising or publicity pertaining to the software without specific, written prior 
permission. Title to copyright in this software and any associated documentation will at all times remain with copyright holders.



    Novell Confidential Manual (exteNd doc template – 31 March 2004)
Contents

About This Book. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

1 Preparing to Install exteNd 5  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
About the installation program . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Before you install . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Preparing your computer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Making installation decisions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Choosing an installation option . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Choosing an installation mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Choosing a database for SilverMaster  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Using MySQL with exteNd 5 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Starting the install  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
What gets installed  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Services  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Environment variables. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Registry keys  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Startup items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Installing in console mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Choosing product features during a custom install . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Deploying the Express Portal  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
About the Express Portal  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
When to deploy the Express Portal yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Installing the deployment tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Setting up the Express Portal database  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Deploying the Express Portal project  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Testing the deployed Express Portal  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Uninstalling exteNd 5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Contacting Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Information about your environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Information about your problem  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

2 Express and Server Express Installs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
About the Express install option  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
About the Server Express install option. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Running the installer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

3 Server Install  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
About the Server install option. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Running the installer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

4 Tools Install  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
About the Tools install option. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Running the installer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

5 Custom Install  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
About the Custom install option . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Running the installer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Installing Composer Server for an existing application server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

6 Installing the exteNd Application Server as a Service or Daemon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
About services and daemons  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
1



Novell Confidential Manual (exteNd doc template – 31 March 2004)
What can run as a service or daemon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Running as a Windows service. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

Creating a Windows service. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Starting a Windows service  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Starting automatically after reboot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Passing command-line arguments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Service dependencies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Running as UNIX/Linux daemons. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Manual start of exteNd server daemon process. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Server console output  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Passing command-line arguments to exteNd background processes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Starting exteNd servers automatically after a reboot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Starting exteNd servers as a user other than root . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Running on NetWare  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
2   Installing Novell exteNd



    Novell Confidential Manual (exteNd doc template – 31 March 2004)
About This Book

Purpose

This book describes how to install the Novell® exteNd™ suite of products.

Audience

This book is for users and/or administrators responsible for installing and configuring the Novell exteNd 
product suite for both development and production environments.
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1 Preparing to Install exteNd 5

This chapter presents an overview of the Novell exteNd 5 product suite installation program. The 
installation program is self-documenting, but there are some decisions you need to make before you run 
the install. This chapter helps you make them.

Topics include:

About the installation program

Before you install

Starting the install

What gets installed

Installing in console mode

Deploying the Express Portal

Uninstalling exteNd 5

Contacting Technical Support

Latest information For the latest information on hardware and software requirements, supported 
databases, and specific install issues, see the Release Notes.

About the installation program
The installation program is an Install Anywhere wizard that is similar on all platforms. There are several 
options for installing the Novell exteNd suite:

Option Description Platform

Express Installs all suite products and features using a 
default configuration

Autoconfigures MySQL

Deploys the Express Portal

Windows, 
Linux

Server 
Express

Installs all server components

Autoconfigures MySQL

Deploys the Express Portal

Windows, 
Linux

Server Installs only the server components Windows, 
UNIX, Linux

Tools Installs only the application design tools Windows, 
Linux

Custom Lets you select options to install a specific 
configuration of products and features

Lets you install exteNd features to a third-party 
application server

Windows, 
UNIX, Linux, 

NetWare®
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Before you install
This section explains what you need to know and do before installing exteNd 5:

Preparing your computer

Making installation decisions

Choosing an installation option

Choosing an installation mode

Choosing a database for SilverMaster

Using MySQL with exteNd 5

Preparing your computer

If you have a previously installed version of any Novell exteNd product, uninstall it before installing this 
version of the Novell exteNd 5 suite.

For details, see “Uninstalling exteNd 5” on page 14.

Making installation decisions

These are the decisions you need to make before you install Novell exteNd:

What to decide Considerations For information see

Which install option 
will you use?

Applies to: Windows, UNIX, Linux, and NetWare

Details: The different install options are 
customized for various typical uses

“Choosing an installation 
option” on page 3

Which install mode will 
you use?

Applies to: UNIX and Linux

Details: You can run the installation program in 
either graphical mode or console mode (on 
Windows and NetWare, the installation program 
always runs in graphical mode)

“Choosing an installation 
mode” on page 4

Which database will 
you use for your 
SilverMaster?

Applies to: Windows, UNIX, and Linux (on 
NetWare, the suite install uses the existing 
exteNd Application Server and SilverMaster 
installed with NetWare)

Details: The exteNd Application Server requires 
a SilverMaster database to maintain its own 
system information; you need to specify a 
database of a supported type (DBMS) to use as 
SilverMaster

“Choosing a database for 
SilverMaster” on page 4

Should you configure 
the exteNd Application 
Server to run as a 
service or daemon?

Applies to: Windows (on UNIX and Linux, this is 
done after installation; on NetWare, the exteNd 
Application Server automatically starts by default 
via autoexec.ncf)

Details: If you want the exteNd Application 
Server to restart automatically whenever its host 
machine reboots, configure it to run as a 
Windows service or UNIX/Linux daemon

Chapter 6, “Installing the 
exteNd Application Server 
as a Service or Daemon”
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Choosing an installation option

These are the installation options available with exteNd 5: 

Install option What it does Platforms

Express This is the simplest way to get started using the exteNd suite of 
products. In addition to installing all of the design tools and server 
components (including the exteNd Application Server), it creates 
and configures a MySQL database for use as SilverMaster and 
deploys a portal project (Express Portal) that can be used as your 
starting point for development, testing, or learning.

See Chapter 2, “Express and Server Express Installs”.

Windows, Linux

Server 
Express

Installs the server components of exteNd (including the exteNd 
Application Server), but not the designers and tools used for 
development. The Server Express install creates and configures a 
MySQL database for use as SilverMaster and deploys a portal 
project (Express Portal) that can be used as your starting point for 
development, testing, or learning.

See Chapter 2, “Express and Server Express Installs”.

Windows, Linux

Server Installs the server components of exteNd (including the exteNd 
Application Server), but not the designers and tools used for 
development. The Server install asks which type of database you 
will use for SilverMaster and requests specific configuration 
information such as port numbers and passwords. The Server 
install is appropriate for machines that will be hosting exteNd 
applications.

See Chapter 3, “Server Install”.

Windows, UNIX, 
Linux

Tools The Tools option installs the exteNd design tools used for 
application development.

See Chapter 4, “Tools Install”.

Windows, Linux

Custom The Custom option allows you to select which exteNd features are 
installed on your machine. You can specify your own preferences 
for databases, port numbers, and passwords.

Custom is also the option to choose if you want to install exteNd 
features to a third-party J2EE application server (such as 
WebLogic, WebSphere, or Tomcat) instead of using the exteNd 
Application Server.

See Chapter 5, “Custom Install”.

All platforms
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Choosing an installation mode

You can choose to run the installation program in one of the following modes (depending on your 
platform):

No matter which mode you use, the installation program will request the same information from you and 
install exteNd 5 with the same result.

Choosing a database for SilverMaster

The SilverMaster is a database used by the Novell exteNd Application Server. There is one SilverMaster 
for each application server or cluster. The SilverMaster keeps track of all deployment databases used by 
the application server and also holds the application server’s system tables—such as tables containing 
security group and user information. Applications can also be deployed to the SilverMaster.

Making a DBMS choice

When choosing a DBMS to host your SilverMaster, consider the following platform issues:

The application server can communicate with multiple database engines at once. For example, you can 
install your SilverMaster database on MySQL and have all of your deployment databases on another 
DBMS, such as Oracle.

Install mode Description

Graphical mode Graphical mode displays the installation program as a window-
based wizard. It is the default mode when you run the 
installation program on any platform.

Graphical mode is appropriate for most users.

NOTE:  Most of the examples in this guide show the 
installation program running in graphical mode (except where 
indicated).

Console mode Console mode displays the installation program as a series of 
text-based prompts on the console. It is an alternative way to 
run the installation program on the following platforms:

UNIX

Linux

Console mode is appropriate for more advanced users.

For details on using this mode, see “Installing in console 
mode” on page 9.

Platform DBMS considerations for SilverMaster

Windows, 
Linux

The Express and Server Express install options automatically 
install and configure MySQL. Alternatively, you can choose any 
supported DBMS for SilverMaster by using other install options.

NetWare MySQL is automatically installed and configured as SilverMaster 
during the NetWare installation. 

UNIX You must be using a supported DBMS product and create a 
database to be used as SilverMaster before running the install 
program.
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Preparing the database to be a SilverMaster

NOTE:  If you are using the Express or Server Express option, the install automatically creates a MySQL 
database. Otherwise, you will have to create a database. If you are using the Custom option on Windows 
or Linux, a MySQL database can be created for you.

Preparing the database involves two operations:

Creating the database

Setting up the database

Creating the database You need to create a database to use as your SilverMaster before installing 
the application server. 

Setting up the database The application server must be able to connect to the database you want to 
use as SilverMaster (as well as any other databases you want it to access). The application server acts as 
a database client—so it requires any database client software, ODBC driver, JDBC driver, and any 
configuration necessary for an application connecting to a particular database.

The steps for setting up a database differ for the different database types (Oracle, and so on). 

For details on setting up your database type, see the appropriate chapter in the exteNd Application 
Server Database Configuration Guide.

For more information about the SilverMaster database and setting it up, see the exteNd Application 
Server Administrator’s Guide (especially the chapter on data source configuration).

Using MySQL with exteNd 5

Default port number

MySQL is installed at port number 63306 when configured by the exteNd suite installer. This is to avoid 
conflicts with any other MySQL server running on the same machine.

MySQL on Windows

Running the Express or Server Express option installs MySQL. If you have an existing installation of 
MySQL running as a service on Windows, that MySQL service will be overwritten and your existing 
my.ini file (in the Windows product directory) will be renamed my.ini.bak.

If you want to avoid installing MySQL during the exteNd installation, use the Custom option and deselect 
MySQL.

MySQL on Linux

When installing MySQL on Linux, the exteNd installation program does not set up a MySQL daemon. 
It’s recommended that you set up a daemon yourself to automatically restart MySQL whenever your 
system reboots. Otherwise, you can start MySQL manually by executing the script StartMySQL.sh in 
the Novell exteNd mysql directory.

When you install as root user on Linux, the installation program edits the /etc/password and /etc/group 
files with entries required to start MySQL.

MySQL on NetWare

MySQL and the exteNd Application Server are installed as part of the NetWare installation program. The 
exteNd 5 suite does not reinstall either the MySQL SilverMaster or the application server during the suite 
install.
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Starting the install
When you’re ready to install exteNd 5, read this section to learn about starting the exteNd installation 
program on your platform. You can get the installation program from the exteNd product CD or by 
downloading one of the following files from the Novell Web site:

After you download one of these archives, extract its contents to your file system. Then you can start the 
install:

What gets installed
This section lists what gets installed or started during the installation:

Files

Services

Environment variables

Registry keys

Startup items

If you uninstall manually, you need to make sure these are deleted or stopped.

Platform File to download

Windows Novell_exteNd5nn_windows.zip

Solaris Novell_exteNd5nn_solaris.tar

Linux Novell_exteNd5nn_linux.tar

NetWare Novell_exteNd5nn_netware.zip

Platform How to start the exteNd install

Windows 1 Find the file xtndInst.exe on the exteNd product CD or on 
your file system.

2 Run this executable file.

Solaris 1 Find the file xtndInst_sol.bin on the exteNd product CD or on 
your file system.

2 Type:

sh xtndInst_sol.bin

Linux 1 Find the file xtndInst_lnx.bin on the exteNd product CD or on 
your file system.

2 Type:

sh xtndInst_lnx.bin

NetWare 1 Find the file install.NCF (and accompanying archive 
xtndInst.jar) on the exteNd product CD or on your file system.

2 Run this NCF file.

NOTE:  You may need to edit install.NCF before running it from 
your file system. Make sure the java command line in install.NCF 
specifies the correct path for the xtndInst.jar file. For example:

java -cp sys:\xtndInst.jar install

Alternatively, you can execute this java command line directly 
(instead of using the install.NCF file).
6   Installing Novell exteNd



Novell Confidential Manual (exteNd doc template – 31 March 2004)
Files

The installation program installs into the directory of your choice. The default depends on your platform:

If you are doing a manual uninstall, there are some things you may want to preserve:

Any profiles, projects, and configuration files you have created or modified that are stored in the 
Novell exteNd directories

Any files under MySQL\data (they will be overwritten during an Express or Server Express 
install)

Services

In Windows, the installation program creates services as needed for the features you’ve chosen. These 
services may include:

Platform Default install directory

Windows C:\Program Files\Novell\exteNd5

UNIX, Linux /opt/novell/exteNd5

NetWare SYS:\exteNd

Category Service Registry keys

Application server Novell exteNd 
Application Server

My Computer\
HKEY_LOCAL_MACHINE\
SYSTEM\ControlSet001\
Services\exteNdAppServernn

Novell exteNd 
Application Server 
Cache Manager

My Computer\
HKEY_LOCAL_MACHINE\
SYSTEM\ControlSet001\
Services\exteNdCachemgrnn

Novell exteNd 
Application Server 
Dispatcher

My Computer\
HKEY_LOCAL_MACHINE\
SYSTEM\ControlSet001\
Services\exteNdDispatchernn

Novell exteNd 
Application Server 
Load Manager

My Computer\
HKEY_LOCAL_MACHINE\
SYSTEM\ControlSet001\
Services\exteNdLoadmgrnn

exteNd Director exteNd Director 
Cache Coordinator

My Computer\
HKEY_LOCAL_MACHINE\
SYSTEM\ControlSet001\
Services\CacheCoordinator

exteNd Director DRE My Computer\
HKEY_LOCAL_MACHINE\
SYSTEM\ControlSet001\
Services\DirectorDRE

MySQL server mysql My Computer\
HKEY_LOCAL_MACHINE\
SYSTEM\ControlSet001\
Services\MySQL
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Environment variables

In Windows, the following are defined as system variables. In UNIX/Linux, they are defined in the 
.profile file.

NOVELL_EXTEND_APPSERVER_HOME

(SILVERSTREAM_HOME maps to the same location; it is provided for backward compatibility)

NOVELL_EXTEND_COMPOSER_HOME

NOVELL_EXTEND_DIRECTOR_DEV_HOME

NOVELL_EXTEND_DIRECTOR_HOME

(SILVERSTREAM_DIRECTOR_HOME maps to the same location; it is provided for backward 
compatibility)

NOVELL_EXTEND_HOME

NOVELL_EXTEND_WORKBENCH_HOME

AGCLASSPATH If you installed MySQL as part of the exteNd install, the MySQL driver is added to 
the AGCLASSPATH environment variable. For example:

C:\Program Files\Novell\exteNd5\MySQL\jdbc\mysql-connector-java-3.0.10-stable-
bin.jar

In UNIX/Linux, AGCLASSPATH is defined in the Novell exteNd AppServer/.agprofile file.

Path modifications In Windows, path environment variables are modified as follows:

Registry keys

In Windows, the following registry keys are defined:

Startup items

In Windows, the exteNd install creates the following program group on the Start menu:

Novell exteNd n.n

Path Modifications

User path C:\Program Files\Novell\exteNd5\Director\autonomy

System path C:\Program Files\Novell\exteNd5\AppServer\bin;
C:\Program Files\Novell\exteNd5\Director\autonomy

Application Registry key

exteNd Application 
Server

My Computer\
HKEY_LOCAL_MACHINE\SOFTWARE\Novell\exteNd\
AppServer\n.n

exteNd Director™ My Computer\
HKEY_LOCAL_MACHINE\SOFTWARE\Novell\exteNd\
Director\n.n

exteNd Director tools My Computer\
HKEY_LOCAL_MACHINE\SOFTWARE\Novell\exteNd\
Workbench\n.n
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Installing in console mode
If you’ve decided to run the installation program in console (text-based) mode, read this section to learn 
how.

For background information about the modes available when running the installation program on 
your platform, see “Choosing an installation mode” on page 4.

To run the installation program in console mode:

1 At the command prompt, start the installation program with the -i console switch. Here’s the syntax 
for both UNIX and Linux:

sh installer-filename -i console

For example:

2 Follow the prompts as they display on the console.

During the installation program, the following commands are available (at just about any time) to 
let you control its operation:

Choosing product features during a custom install

If you request a custom install while in console mode (by picking Customize... at the Choose Install Set 
prompt), the installation program displays the Choose Product Features prompt, including a list of the 
current feature selections:

Choose Product Features
-----------------------

ENTER A COMMA_SEPARATED LIST OF NUMBERS REPRESENTING THE FEATURES YOU WOULD 
LIKE TO SELECT, OR DESELECT. TO VIEW A FEATURE'S DESCRIPTION, ENTER 
'?<NUMBER>'.  PRESS <RETURN> WHEN YOU ARE DONE:

    1- [X] exteNd Suite
    2-  |-[X] Sample Database in MySQL
    3-  |-[X] exteNd Messaging Platform
    4-  |-[X] exteNd Application Server
    5-     |-[X] Application Server
    6-     |-[X] Deployment
    7-     |-[X] SMC
    8-     |-[X] Cluster tools
    9-     |-[X] SilverJ2EEClient
   10-     |-[X] UDDI services
   11-  |-[X] Web Services SDK
   12-  |-[X] Director
   13-     |-[X] Director Designer
   14-     |-[X] Director Tools
   15-     |-[X] Autonomy DRE
   16-  |-[X] Express Portal

On this platform You type

Solaris sh xtndInst_sol.bin -i console

Linux sh xtndInst_lnx.bin -i console

Type this command If you want to

back Go back to the previous prompt (to change your 
response or just review it)

quit Cancel the install
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   17-  |-[X] Composer Server
   18-  |-[X] LDAP Utility
   19- [X] Documentation
   20- [ ] Composer Server for existing exteNd Application Server
   21- [ ] Composer Server for WebLogic
   22- [ ] Composer for WebSphere
   23- [ ] Composer Server for Tomcat
   24- [X] MySQL

Please choose the Features to be installed by this installer.
   : 

This section provides some tips for completing this part of the install in console mode.

What the symbols mean Here’s a key to the Choose Product Features list:

How to select and deselect The Choose Product Features prompt works by toggling any item(s) 
you specify:

You can toggle multiple items at a time by typing the appropriate item numbers in a comma-separated 
list. For example:

8,15,22

Toggling a parent item sets all of its children to the same state.

How to review your selections After you respond to the Choose Product Features prompt, you can 
review your selections by typing the back command. You can then make further changes or continue on 
to the next install prompt.

Deploying the Express Portal
Read this section to learn when you may need to deploy the Express Portal manually after installing 
exteNd and how to do it:

About the Express Portal

Symbol Meaning

[X] The feature is selected and will be installed.

[ ] The feature is deselected and will not be installed.

[-] The feature is partially selected. You see this symbol for a parent item 
when one or more of its children are deselected. It indicates that a 
subset of the feature will be installed.

IMPORTANT:  If you deselect all of a parent item’s children but leave 
the parent item partially selected, some files related to that parent item 
may get installed. If this is not what you want, be sure to deselect the 
parent item too.

If you Then

Type the number of a selected or 
partially selected item:

8

That item will be deselected

Type the number of a deselected item:

22

That item will be selected
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When to deploy the Express Portal yourself

Installing the deployment tools

Setting up the Express Portal database

Deploying the Express Portal project

Testing the deployed Express Portal

About the Express Portal

To help you start working with applications right away, exteNd provides a default project called Express 
Portal. It’s a complete portal application based on a standard exteNd Director EAR project.

The source files for the Express Portal project are installed in the Novell exteNd Projects\Express 
directory. The Express Portal also requires access to a database to store and manage its application data 
at runtime.

For further details on this project and to learn how the application works, see the chapter About the 
Express Portal in the exteNd Director Portal Guide.

When to deploy the Express Portal yourself

The exteNd installation program automatically deploys the Express Portal if you request an Express or 
Server Express install (which are available when the target platform is Windows or Linux). In all other 
cases, you must deploy the Express Portal yourself after installation if you want to have it running on 
your application server.

If your target platform is UNIX or NetWare, note that Server and Custom are the only install options 
available, neither of which performs the Express Portal deployment. So for these server platforms, you 
must always deploy the Express Portal yourself if you want to use it.

Installing the deployment tools

To deploy the Express Portal yourself, you’ll want the exteNd designers, which include built-in tools for 
application generation and deployment. You can install the exteNd designers on either a Windows or 
Linux machine; select one of the following install options:

Express

Tools

Custom

You can then use that Windows or Linux machine to deploy to your application server, which may be 
running on Windows, UNIX, Linux, or NetWare.

Setting up the Express Portal database

Before deploying, you also need to set up the database required by the Express Portal. It will be used to 
store the Express Portal database schema and data.

To set up the Express Portal database:

1 Create a new database or find an existing one to use; it must be a database type supported by 
exteNd applications (for a list, see the Release Notes).

IMPORTANT:  To avoid conflicts, don’t reuse the existing database of another deployed Express 
Portal.
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2 Create a JDBC connection pool on your application server for access to that database. Name the 
connection pool ExpressPortal.

To create a connection pool on the Novell exteNd Application Server, use the SMC (Server 
Management Console). For details, see the chapter on data source configuration in the exteNd 
Application Server Administrator’s Guide.

If you’re deploying to NetWare

If you are preparing to deploy the Express Portal to the Novell exteNd Application Server on NetWare, 
there are some details you need to know about for proper setup of the Express Portal database.

Database type MySQL 4.0 (which is shipped with NetWare 6.5 Support Pack 2) is not supported for 
the Express Portal database. But you can use MySQL 4.1 (which is installed with the exteNd 5 suite on 
Windows and Linux) or any other database listed in the Release Notes. To use MySQL 4.1:

1 Do an Express install of exteNd on a Windows or Linux machine.

2 Use MySQL-Front to create a new MySQL database on that machine. Give this database a unique 
name, such as ExpressPortalNW.

Connection pool If you do create a MySQL database for the Express Portal, follow these steps to set 
up the JDBC connection pool for it on the NetWare server:

1 Open the Server Management Console in the NetWare GUI by selecting Novell>exteNd 
Application Server>SMC.

2 Go to Pools and click the Add button.

3 Specify MySQL as your Database Platform and accept the pre-configured settings. Then click 
Next.

4 Specify the following, then click Next.

The Pool Name ExpressPortal

The User Name and Password for your MySQL database

5 Edit the default JDBC URL as follows, then click Next.

Replace %HOST% with the full IP address and port number of your MySQL database server 
(note that the default MySQL port configured by the exteNd suite install is 63306)

Replace %DBNAME% with the database name (such as ExpressPortalNW)

The resulting JDBC URL should look something like this:
jdbc:mysql://11.222.333.44:63306/ExpressPortalNW

6 When the Properties panels display, simply click Next and then Finish.

Deploying the Express Portal project

The Express Portal is an exteNd Director EAR project, so you’ll use the exteNd Director tools to deploy 
it to your application server.

To deploy the Express Portal project:

1 Go to the Windows or Linux machine where you installed the exteNd designers.

2 Start the exteNd Director development environment by doing one of the following:

Platform What to do

Windows 1 Go to the list of all programs on the Windows Start menu.

2 Select Novell exteNd n.n>Director>Director Designer.
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3 If the Express Portal project (Express.spf) doesn’t open by default, open it yourself by selecting 
File>Open Project.

You’ll find Express.spf in the Novell exteNd Projects/Express directory on your local Windows or 
Linux machine.

4 Select Project>Director>Configuration, then go to the Framework tab.

5 Edit the setting Server Accessible Temp Directory to specify a temporary directory on your 
application server machine (needed to store some files for exteNd Director). Then click OK.

Note that the path you specify is relative to your application server machine.

6 Select Project>Deployment Settings, then go to the Server Profiles tab and click the New button.

When the New Server Profile dialog displays, fill it in to create a server profile that specifies your 
target application server. For example, these settings are for an exteNd application server running 
on a NetWare machine:

Click OK to return to the Deployment Settings dialog.

7 Specify the User name and Password for the administrator of your application server.

8 Go to the Deployment Info tab to specify any additional information required by the type of 
application server you are deploying to.

For an exteNd application server, click the browse (...) button to select the Novell Deployment 
Plan to use: Express_DeplPlan.xml (in the Novell exteNd Projects/Express directory).

9 Click OK to complete the Deployment Settings dialog.

10 Select Project>Deploy Archive to begin deploying the Express Portal project to your specified 
application server.

Watch the Output Pane for notification when the deployment has completed.

For more information, see the chapter on deploying exteNd Director applications in Developing 
exteNd Director Applications.

Windows, 
Linux

1 Go to the Novell exteNd tools/bin directory.

2 Run the executable file named xd.

If your application 
server platform is The temp directory setting is typically

Windows C:\Program Files\Novell\exteNd5\temp

UNIX, Linux /opt/novell/exteNd5/temp

NetWare SYS:\exteNd\temp

Platform What to do
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Testing the deployed Express Portal

Once deployment is done, use a Web browser to see the Express Portal running on your application 
server. Go to this URL:

http://serverhost:port/ExpressPortal

For an exteNd application server, the port number is typically one of the following, depending on the 
platform:

Uninstalling exteNd 5
If you need to remove an existing exteNd 5 installation, you can run the exteNd 5 uninstall program 
that’s provided on your machine. To start the uninstall program, use one of the following approaches 
(depending on your platform).

IMPORTANT:  Before you uninstall (by using the uninstall program or manually), make sure you shut 
down all exteNd 5 programs, services, and daemons.

The uninstall program will run in the same mode you used when installing exteNd 5, either graphical 
mode or console mode.

The uninstall program won’t remove files that were created or changed after exteNd 5 was installed. You 
can examine the remaining files to decide if there are any (as described in “Files” on page 7) that you 
want to keep. You can remove the other files and folders yourself.

Uninstalling manually As an alternative to using the uninstall program, you can manually remove the 
files and other artifacts of your existing exteNd 5 installation.

See the section on “What gets installed” on page 6 for a list of files and other artifacts to remove.

Application 
server platform Typical port number

Windows 80

UNIX, Linux 8080

NetWare 83

Platform How to run the uninstall program

Windows 1 Go to the list of all programs on the Windows Start menu.

2 Select Novell exteNd n.n>Uninstall Novell exteNd Suite 5.

1 Go to the Windows Control Panel and select Add or Remove 
Programs.

2 Select Novell exteNd Suite 5, then click the Change/Remove 
button.

Windows, 
UNIX, 
Linux

1 Go to the Novell exteNd UninstallerData/exteNdSuite directory.

2 Run the executable file named Uninstall_ExteNd5_Suite.

Windows, 
UNIX, 
Linux, 
NetWare

At the command prompt, type:

java -cp 
exteNd_dir/UninstallerData/exteNdSuite/uninstaller.jar 
uninstall
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After uninstalling No matter how you uninstall exteNd 5, make sure you reboot your machine when 
the uninstall is done.

Contacting Technical Support
To learn about the online product support available to you, visit the Novell exteNd Web site 
(http://extend.novell.com/).

If you contact the Novell exteNd support staff for assistance, you will be asked to provide the following:

Information about your environment

Information about your problem

Information about your environment

Information about your problem
Does the problem occur in the development environment or at runtime?

What was the specific action that caused the error? 

What error message did you see? 

Can the problem be recreated consistently?

What are the exact steps to recreate the error? Please be prepared to provide an example

Category Details

Product versions Available from the About... help menu

Product type The suite edition you are using

Operating system The platform for your server

Database platform for 
SilverMaster

The DBMS you are using for your SilverMaster

Other databases The DBMSs you are using for application 
deployment and application data, including versions

Database drivers The types and versions of the database drivers you 
are using

Browser The name and version number of the Web browser 
you are using

Java Virtual Machine 
version (JVM)

Displayed when you start the exteNd Application 
Server

Proxy servers and firewalls Whether you are using a proxy server or firewall in 
your system configuration
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2 Express and Server Express Installs

This chapter presents an overview of the Express and Server Express installation options. These options 
allow you to quickly install the entire suite or the server features of the suite with minimal input required. 
Topics include:

About the Express install option

About the Server Express install option

Running the installer

About the Express install option
The Express install is the simplest way for you to get started using the exteNd suite of products. In 
addition to installing all of the design tools and server components (including the exteNd Application 
Server), it creates and configures a MySQL database for use as SilverMaster and deploys a portal project 
(Express Portal) that can be used as your starting point for development, testing, or learning. Express is 
available on Windows and Linux.

About the Server Express install option
The Server Express option installs the server components of exteNd (including the exteNd Application 
Server), but not the designers and tools used for development. The Server Express install automatically 
creates and configures a MySQL database for use as SilverMaster and deploys the Express Portal. This 
install option is appropriate for machines that will be hosting exteNd applications. Server Express is 
available on Windows and Linux.

Running the installer
Although there are different things happening behind the scenes, the install wizard asks for the same 
input during the Express and Server Express installations.

IMPORTANT:  Novell recommends uninstalling any previous version of exteNd before reinstalling. If you 
choose to install over an existing exteNd installation and use the Express or Server Express install, the 
installer will overwrite the existing SilverMaster and ExpressPortal databases. Any changes made to 
those databases will be lost.

To install exteNd using the Express or Server Express option:

1 Exit all other programs (if running on Windows), then launch the exteNd installation program as 
described in “Starting the install” on page 14.

The product splash screen displays, including a dropdown for selecting the language in which you 
want to see the install prompts.
Express and Server Express Installs 1



Novell Confidential Manual (exteNd doc template – 31 March 2004)
2 Select one of the available language choices and click OK.

3 When the Introduction panel displays, read it then click Next.

The License Agreement panel displays.

4 To continue with the install, you must accept the license agreement (by selecting the 
corresponding radio button). Then click Next.

5 When the Installation Key panel displays, type your key (note that it’s case-sensitive) then click 
Next.

NOTE:  Your installation key determines which product features are available to be installed.

The Choose Install Set panel displays.

6 Select Express or Server Express (as appropriate), then click Next.

7 When the Choose Install Location panel displays, accept the default or specify a different 
directory where you want exteNd to be installed. Then click Next.

NOTE:  If the specified directory doesn’t exist, you’ll be prompted to confirm that you want it 
created. Click OK.

8 If the Configure MySQL Server panel displays, accept the default (63306) for MySQL Port or 
specify a different port number on which MySQL is to listen. Then click Next.

For more information, see “Using MySQL with exteNd 5” on page 13.

The MySQL Root Password panel displays.

9 Type the database password to be used for the MySQL root user, then click Next.

IMPORTANT:  When reinstalling to an existing location, specify the existing MySQL root 
password.
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10 When the HTTP Port Number panel displays, accept the default (80 on Windows, 8080 on Linux) 
or specify a different port number on which the exteNd Application Server is to listen. Then click 
Next.

For more about port usage, see the chapter on running the server in the exteNd Application 
Server Administrator’s Guide.

The Admin User Name and Password panel displays.

11 Type the user name and password to be used for the initial exteNd administration account.

When creating this account, the installation program will assign Locksmith privileges to it. Your 
exteNd administrator will log in to this account when managing the application server and other 
aspects of the exteNd system.

For more information, see the chapter on setting up users and groups in the exteNd 
Application Server Administrator’s Guide.

Click Next to advance to the Pre-Installation Summary panel.

12 If the summary matches the result you want, click Install to proceed with the installation.
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3 Server Install

This chapter presents an overview of the Server installation option. Topics include:

About the Server install option

Running the installer

About the Server install option
The Server option installs the server components of exteNd (including the exteNd Application Server), 
but not the designers and tools used for development. The Server install asks which type of database you 
will use for SilverMaster and requests specific configuration information such as port numbers and 
passwords. The Server install is appropriate for machines that will be hosting exteNd applications. Server 
is available on Windows, UNIX, and Linux.

NOTE:  On NetWare, don’t choose the Server option listed by the exteNd installation program (because 
it lacks some of the exteNd components you need). Choose the Custom option instead (see Chapter 5, 
“Custom Install”).

Running the installer
When you run the Server install, the questions presented vary depending on selections you make along 
the way, as well as which install key you are using.

To install exteNd using the Server option:

1 Exit all other programs (if running on Windows), then launch the exteNd installation program as 
described in “Starting the install” on page 14.

The product splash screen displays, including a dropdown for selecting the language in which you 
want to see the install prompts.

2 Select one of the available language choices and click OK.

3 When the Introduction panel displays, read it then click Next.

The License Agreement panel displays.

4 To continue with the install, you must accept the license agreement (by selecting the 
corresponding radio button). Then click Next.

5 When the Installation Key panel displays, type your key (note that it’s case-sensitive) then click 
Next.

NOTE:  Your installation key determines which product features are available to be installed.

The Choose Install Set panel displays.

6 Select Server, then click Next.
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7 When the Choose Install Location panel displays, accept the default or specify a different 
directory where you want exteNd to be installed. Then click Next.

NOTE:  If the specified directory doesn’t exist, you’ll be prompted to confirm that you want it 
created. Click OK.

The installation program prompts for the type of database you are providing to be used as 
SilverMaster (which is required by the exteNd Application Server).

8 Select your database type from the list of supported DBMSs, then click Next.

9 If the Set Driver AGCLASSPATH panel displays, specify the full path of the JDBC driver (JAR 
file) that you want exteNd to use when connecting to the SilverMaster database. Then click Next.

The Setup or Upgrade SilverMaster panel displays.

10 Select one of the following radio buttons, then click Next.
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For more information about the SilverMaster database and setting it up, see the exteNd 
Application Server Administrator’s Guide (especially the chapter on data source configuration).

11 When the installation program prompts for JDBC driver settings, specify the JDBC URL (and any 
attributes) needed for your driver to connect to the SilverMaster database. Then click Next.

For more information on these settings, see your JDBC driver documentation and the chapter 
for your DBMS in the exteNd Application Server Database Configuration Guide.

The SilverMaster DB Username and Password panel displays.

12 Specify the following, then click Next.

Select this If you

Setup a new SilverMaster 
database

Have a database that has never before been 
used as a SilverMaster.

Upgrade an existing 
SilverMaster database

Have an existing SilverMaster database that you 
would like to upgrade to the current version of 
exteNd. This choice will retain all database 
tables, security settings, and user information.
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The DB name of the SilverMaster database (the default is SilverMaster50)

The user name and password that exteNd will use when connecting to the SilverMaster 
database

13 When the HTTP Port Number panel displays, accept the default (80 on Windows, 8080 on 
UNIX/Linux) or specify a different port number on which the exteNd Application Server is to 
listen. Then click Next.

For more about port usage, see the chapter on running the server in the exteNd Application 
Server Administrator’s Guide.

14 The installation program asks if you want to restrict access to the exteNd Application Server. 
Select the appropriate radio button, then click Next.

When access is restricted (the default), unauthorized users will not be able to perform 
administration operations or browse directory listings; this is especially important for production 
servers. If you are setting up a server for development or testing, you may not always need (or 
want) to restrict access.

For more information, see the chapter on using security in the exteNd Application Server 
Administrator’s Guide.

The Admin User Name and Password panel displays.

15 Type the user name and password to be used for the initial exteNd administration account. Then 
click Next.
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When creating this account, the installation program will assign Locksmith privileges to it. Your 
exteNd administrator will log in to this account when managing the application server and other 
aspects of the exteNd system.

For more information, see the chapter on setting up users and groups in the exteNd 
Application Server Administrator’s Guide.

16 If you are installing on Windows, the installation program asks if you want to run the exteNd 
Application Server as a service. Select the appropriate radio button, then click Next.

For details on running as a service, see Chapter 6, “Installing the exteNd Application Server 
as a Service or Daemon”.

The Director Cache Coordinator Port panel displays.

17 Accept the default (54490) for Cache Coordinator RMI Port, or specify a different port number. 
This port is used by exteNd Director to communicate with different instances of an exteNd Director 
application in a clustered server environment.

Click Next to advance to the Pre-Installation Summary panel.

18 If the summary matches the result you want, click Install to proceed with the installation.
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4 Tools Install

This chapter presents an overview of the Tools installation option. Topics include:

About the Tools install option

Running the installer

About the Tools install option
The Tools option installs the exteNd design tools used for application development. Tools is available on 
Windows and Linux.

Running the installer

To install exteNd using the Tools option:

1 Exit all other programs (if running on Windows), then launch the exteNd installation program as 
described in “Starting the install” on page 14.

The product splash screen displays, including a dropdown for selecting the language in which you 
want to see the install prompts.

2 Select one of the available language choices and click OK.

3 When the Introduction panel displays, read it then click Next.

The License Agreement panel displays.

4 To continue with the install, you must accept the license agreement (by selecting the 
corresponding radio button). Then click Next.

5 When the Installation Key panel displays, type your key (note that it’s case-sensitive) then click 
Next.

NOTE:  Your installation key determines which product features are available to be installed.

The Choose Install Set panel displays.

6 Select Tools, then click Next.
Tools Install 1



Novell Confidential Manual (exteNd doc template – 31 March 2004)
7 When the Choose Install Location panel displays, accept the default or specify a different 
directory where you want exteNd to be installed. Then click Next.

NOTE:  If the specified directory doesn’t exist, you’ll be prompted to confirm that you want it 
created. Click OK.

The Pre-Installation Summary panel displays.

8 If the summary matches the result you want, click Install to proceed with the installation.
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5 Custom Install

This chapter presents an overview of the Custom installation option. Topics include:

About the Custom install option

Running the installer

Installing Composer Server for an existing application server

About the Custom install option
The Custom option allows you to select which exteNd features are installed on your machine. You can 
specify your own preferences for databases, port numbers, and passwords.

Custom is also the option to choose if you want to install exteNd features to a third-party J2EE 
application server (such as WebLogic, WebSphere, or Tomcat) instead of using the exteNd Application 
Server.

Custom is available on all platforms.

Running the installer
When you run the Custom install, the questions presented vary depending on selections you make along 
the way, as well as which install key you are using.

To install exteNd using the Custom option:

1 Exit all other programs (if running on Windows), then launch the exteNd installation program as 
described in “Starting the install” on page 14.

The product splash screen displays, including a dropdown for selecting the language in which you 
want to see the install prompts.

2 Select one of the available language choices and click OK.

3 When the Introduction panel displays, read it then click Next.

The License Agreement panel displays.

4 To continue with the install, you must accept the license agreement (by selecting the 
corresponding radio button). Then click Next.

5 When the Installation Key panel displays, type your key (note that it’s case-sensitive) then click 
Next.

NOTE:  Your installation key determines which product features are available to be installed.

The Choose Install Set panel displays.

6 Select Custom, then click Next.
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The installation program lists the product features available to you, including checkboxes for 
selecting or deselecting particular items.

7 Select or deselect features as needed, so that only the ones you want to install are checked. As you 
work with this list, note that:

You can click any item name to display its description.

The - symbol in a checkbox indicates a parent item that’s partially selected (because one or 
more of its children are deselected). A subset of that feature will be installed.

IMPORTANT:  If you deselect all of a parent item’s children but leave the parent item partially 
selected, some files related to that parent item may get installed. If this is not what you want, be 
sure to deselect the parent item too.

When you’re done making feature selections, click Next.

8 When the Choose Install Location panel displays, accept the default or specify a different 
directory where you want exteNd to be installed. Then click Next.

NOTE:  If the specified directory doesn’t exist, you’ll be prompted to confirm that you want it 
created. Click OK.

9 If you chose to install MySQL:
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9a When the Configure MySQL Server panel displays, accept the default (63306) for the MySQL 
Port or specify a different port number on which MySQL is to listen. On Linux, you can also 
accept the default socket (/tmp/mysql.exteNd.sock) or specify another. Then click Next.

For more information, see “Using MySQL with exteNd 5” on page 13.

The MySQL Root Password panel displays.

9b Type the database password to be used for the MySQL root user, then click Next.

IMPORTANT:  When reinstalling to an existing location, specify the existing MySQL root 
password.

10 If you chose to install the exteNd Application Server, continue with Step 11.

If you chose not to install that feature, skip to Step 17.

11 This part of the install deals with configuring the SilverMaster database used by the exteNd 
Application Server:

If you have MySQL (from this exteNd install or a prior one), the installation program offers to 
create a new MySQL database to use as SilverMaster. The other choice is to provide an 
existing database (of any supported DBMS) yourself. Select the appropriate radio button, then 
click Next.
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If you don’t have MySQL, you won’t get this choice. You must provide an existing database.

Providing an existing database for SilverMaster involves answering these additional install 
questions:

11a When prompted, select your database type from the list of supported DBMSs then click Next.

11b If the Set Driver AGCLASSPATH panel displays, specify the full path of the JDBC driver 
(JAR file) that you want exteNd to use when connecting to the SilverMaster database. Then 
click Next.

The Setup or Upgrade SilverMaster panel displays.

11c Select one of the following radio buttons, then click Next.

Select this If you

Setup a new 
SilverMaster database

Have a database that has never before been 
used as a SilverMaster.
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For more information about the SilverMaster database and setting it up, see the exteNd 
Application Server Administrator’s Guide (especially the chapter on data source 
configuration).

11d When the installation program prompts for JDBC driver settings, specify the JDBC URL 
(and any attributes) needed for your driver to connect to the SilverMaster database. Then click 
Next.

For more information on these settings, see your JDBC driver documentation and the 
chapter for your DBMS in the exteNd Application Server Database Configuration Guide.

The SilverMaster DB Username and Password panel displays.

11e Specify the following, then click Next.

The DB name of the SilverMaster database (the default is SilverMaster50)

The user name and password that exteNd will use when connecting to the SilverMaster 
database

12 When the HTTP Port Number panel displays, accept the default (80 on Windows, 8080 on 
UNIX/Linux) or specify a different port number on which the exteNd Application Server is to 
listen. Then click Next.

For more about port usage, see the chapter on running the server in the exteNd Application 
Server Administrator’s Guide.

13 When the Name Service Port Number panel displays, accept the default (54890) or specify a 
different port number. Then click Next.

14 The installation program asks if you want to restrict access to the exteNd Application Server. 
Select the appropriate radio button, then click Next.

When access is restricted (the default), unauthorized users will not be able to perform 
administration operations or browse directory listings; this is especially important for production 
servers. If you are setting up a server for development or testing, you may not always need (or 
want) to restrict access.

Upgrade an existing 
SilverMaster database

Have an existing SilverMaster database that 
you would like to upgrade to the current version 
of exteNd. This choice will retain all database 
tables, security settings, and user information.

Select this If you
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For more information, see the chapter on using security in the exteNd Application Server 
Administrator’s Guide.

The Admin User Name and Password panel displays.

15 Type the user name and password to be used for the initial exteNd administration account. Then 
click Next.

When creating this account, the installation program will assign Locksmith privileges to it. Your 
exteNd administrator will log in to this account when managing the application server and other 
aspects of the exteNd system.

For more information, see the chapter on setting up users and groups in the exteNd 
Application Server Administrator’s Guide.

16 If you are installing on Windows, the installation program asks if you want to run the exteNd 
Application Server as a service. Select the appropriate radio button, then click Next.

For details on running as a service, see Chapter 6, “Installing the exteNd Application Server 
as a Service or Daemon”.

17 If you chose to install exteNd Director, the Director Cache Coordinator Port panel displays.

Accept the default (54490) for Cache Coordinator RMI Port, or specify a different port number. 
This port is used by exteNd Director to communicate with different instances of an exteNd Director 
application in a clustered server environment.

Click Next to advance to the Pre-Installation Summary panel.

18 If the summary matches the result you want, click Install to proceed with the installation.

Installing Composer Server for an existing application server
During a Custom installation, you can choose to install the exteNd Composer server components to an 
existing application server (one that’s already installed and capable of running). Your options include:

Composer Server for existing exteNd Application Server
Composer Server for WebLogic
Composer Server for WebSphere
Composer Server for Tomcat

If you select one of these options, the installation program will prompt you to provide some information 
about that application server. This information may include (depending on the application server type):
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The root location (directory) where the application server is installed

Which version of the application server you have (if multiple versions are supported)

The user name and password of an administrator to log in to the application server

You’ll also be prompted when you need to have your application server running in preparation for the 
Composer Server install. During the install, your application server will be shut down and restarted as 
needed to configure the exteNd Composer server components.

In some cases, you may need to intervene in this process by manually starting or stopping the 
application server, or by confirming that the application server has started or stopped. The installation 
program will notify you about what to do and when.

For additional notes on installing Composer Server in your environment, see the exteNd Composer 
Release Notes.
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6 Installing the exteNd Application Server as a 
Service or Daemon

This chapter describes how you can configure the exteNd Application Server to restart automatically 
when necessary:

About services and daemons

Running as a Windows service

Running as UNIX/Linux daemons

Running on NetWare

About services and daemons
With high-availability servers in a multiuser environment, it often makes sense to run them as Windows 
services or UNIX/Linux daemons. Running the exteNd Application Server and the database server as a 
service or daemon on the same machine ensures that both services restart automatically when the 
machine reboots. This helps you:

Avoid security risks caused by keeping the server program logged in on the computer running the 
server

Automatically start the server whenever Windows or UNIX/Linux is started

Start the server remotely with the Windows Service Manager or with a UNIX/Linux shell

Run the server with administrative account privileges while you run other programs using your 
local accounts 

Avoid tying the server to a specific user ID

By default, the application server does not run as a service or daemon.

What can run as a service or daemon

The following Novell exteNd Application Server programs can run as services or daemons:

Program Description Runs as

Application Server Serves applications Runs as a desktop program 
by default

Load Manager Manages the activity of 
the servers in a cluster

Usually run as a desktop 
program

Dispatcher Redirects requests to 
application servers

Cache Manager Keeps server caches for 
clusters in sync
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Running as a Windows service
When you run high-availability servers in a multiuser environment, it can make sense to run them as 
Windows services. Running the Novell exteNd Application Server and the database server as services on 
the same machine ensures that both restart automatically whenever the machine reboots. If the 
application server connects to databases on other machines, you should also make sure they restart 
automatically on reboot.

Creating a Windows service

There are two ways to create the Windows services for the exteNd Application Server and cluster servers:

During installation

After installation

During installation

The exteNd installer includes a choice (available with the Server and Custom install options only) to 
automatically create Windows services for the application server and cluster servers.

After installation

The Windows services may also be created after installation by using the utility SilverServiceUtil.exe. 
This is a command-line DOS utility and should be run from a DOS window.  The following commands 
will create the Windows services for the exteNd servers (where nn and n.n refer to the version number of 
the application server):

SilverServiceUtil.exe -create -service exteNdAppServernn -display \
"Novell exteNd Application Server n.n" -program \
%NOVELL_EXTEND_APPSERVER_HOME%\bin\SilverServer.exe

SilverServiceUtil.exe -create -service exteNdCacheMgrnn -display \
"Novell exteNd Cache Manager Server n.n" -program \
%NOVELL_EXTEND_APPSERVER_HOME%\bin\SilverServer.exe

SilverServiceUtil.exe -create -service exteNdLoagMgrnn \
-display "Novell exteNd Load Manager Server n.n" \
-program %NOVELL_EXTEND_APPSERVER_HOME%\bin\SilverServer.exe
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SilverServiceUtil.exe -create -service exteNdDispatchernn \
-display "Novell exteNd Dispatcher n.n" \
-program %NOVELL_EXTEND_APPSERVER_HOME%\bin\SilverServer.exe

Starting a Windows service

The services need to be started after they are created. 

To start a Windows service:

1 Select Administrative Tools in the Windows Control Panel.

2 Open Services and find the Novell exteNd Application Server n.n service.

3 Right-click the service and select Start. 

NOTE:  This procedure may vary a bit on the various Windows platforms. 

The exteNd server does not normally open a DOS console window when it is started as a service. The 
console output is redirected to a text file stored in the 
%NOVELL_EXTEND_APPSERVER_HOME%\temp directory.

Starting automatically after reboot

The services are configured as manual start. To have them restart automatically:

1 Select Administrative Tools in the Windows Control Panel.

2 Open Services and find the Novell exteNd Application Server n.n service.

3 Right-click the service and select Properties. Change the Startup type to Automatic.

Passing command-line arguments

You can specify command-line arguments that will get passed to the exteNd servers when they are started 
as Windows services. To do this you edit the Windows registry entry for the service, using the Windows 
registry editor.
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To specify command-line arguments:

1 From the Start menu select Run.

2 Enter regedit and click OK. This starts the registry editor.

3 In the left panel, expand HKEY_LOCAL_MACHINE, SYSTEM, CurrentControlSet, 
Services.

4 Click the service you want to add command-line parameters for. The registry settings for the 
service displays in the right panel.  

5 Right-click StartupOptions, then select Modify.  

6 Enter the startup command-line options and click OK to save them.

7 Exit the Windows registry editor.

The command-line arguments will be passed into the exteNd server process the next time it is started as 
a service.

Service dependencies

If the exteNd Application Server depends on a database server (or other server) that runs on the same 
machine, the database service must be started before the application server service. 

You should add a service dependency to the application server service to guarantee that the database 
server will be started before the application server.  

You do this with the SilverServiceUtil.exe command-line tool.

Running as UNIX/Linux daemons
All UNIX and Linux distributions of the exteNd Application Server include the extendctl script, which 
can be used to start and stop exteNd server processes in the background.

The installation program also installs sample startup scripts that your system can run to automatically 
start the application server or cluster components as daemons at boot time.

A system administrator with root privileges must copy the sample server and cluster scripts from the 
install directory into your operating system’s boot directory.

Manual start of exteNd server daemon process

The extendctl script can be used to start, stop, and restart server processes.

$NOVELL_EXTEND_APPSERVER_HOME/etc/extendctl

For usage information, use extendctl -h. Here are some examples.

extendctl start -A     (starts the appserver in the background)
extendctl stop -A      (stops the background appserver process)
extendctl restart -A   (restarts the background appserver process)
extendctl status -A    (tests whether the appserver is running)
extendctl tail -A      (starts a "tail -f" on the appserver console output)

The flag -A refers to the application server. Other options are available for use with cluster servers. 

Server path Cluster path

$installationdirectory/etc/silverserver $installationdirectory/etc/silvercluster
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Server console output

When the extendctl script starts an exteNd server in the background, the server’s console output is 
redirected to a file with the following naming convention: 

$NOVELL_EXTEND_APPSERVER_HOME/temp/SilverServer.XXXXX.out

XXXXX begins at 00001 and is incremented by 1 each time a server is restarted.

You can optionally specify an alternate output directory. But you cannot change the naming convention 
for console output files.

The default behavior of the extendctl script is to delete all but the last few output files created by each 
server. The number of output files saved can be changed. And you can always start the output file index 
over again at 00001 by deleting the index file:

$NOVELL_EXTEND_APPSERVER_HOME/temp/.outfile.index

NOTE:  Don't do this unless all exteNd server processes are stopped. 

Passing command-line arguments to exteNd background processes

To pass one or more command-line arguments to the application server (or a cluster server), use the -p 
option with the extendctl script. For example:

extendctl start -A -p "+cp:p /tmp/foo.jar -nomonitor"

This causes the arguments "+cp:p /tmp/foo.jar -nomonitor" to be passed to the application server when 
it is started in the background. The argument to the -p switch must be enclosed in double quotes.

Starting exteNd servers automatically after a reboot

The directory $NOVELL_EXTEND_APPSERVER_HOME/etc contains sample scripts that may be 
copied into the appropriate areas in /etc/init.d or /etc/rc.d. These scripts are named:

silverserver (to start/stop an AppServer process)
silvercluster (to start/stop the cluster control servers)

The variable EXTEND_HOME must be changed in these scripts to reflect the exteNd installation 
directory. These scripts support the start, stop, restart, and status commands.

The way to set up the application server or cluster servers to restart after a reboot varies from system to 
system. See your OS documentation or your UNIX/Linux system administrator for more information. 
Remember that the application server process must be started after any of its dependent daemon 
processes (that is, databases) are started. If the exteNd cluster servers are being used, they must be started 
before the server is started.

Starting exteNd servers as a user other than root

An exteNd Application Server started by the system after a reboot will be running as the root user. 

To specify a different user: 

1 Make sure the server is running. 

2 Start the SMC and connect to the server (see the overview chapter in the exteNd Application Server 
Administrator’s Guide for details). 

3 Select View>Configuration to display the configuration panels. 

4 Select the General panel. 

5 Edit the user name in the Username for server (UNIX only) text box.
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TIP:   The specified user ID must have the proper permissions to files in the exteNd installation 
directory.

6 Restart the server for the changes to take effect.

Now the server will change its effective user ID whenever it starts up. 

IMPORTANT:  The server must be restarted as root. Otherwise, the server will fail to start—either 
because it can't change the user ID or because it can't read from or write to a file. These problems 
can usually be avoided if you ensure that the user ID being set for the server is the user that owns 
the exteNd install directory contents.

Running on NetWare
In NetWare, the autoexec.ncf file is used to automatically restart the exteNd Application Server when the 
NetWare server restarts. When you install the application server, the commands for this are added by 
default to autoexec.ncf.

If you don’t want the application server to restart automatically, you can edit autoexec.ncf to remove 
those commands.
6   Installing Novell exteNd
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